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GENERAL DESCRIPTION

The CNC Lathe System (Light Duty), Model 5300, pro-
vides training in computer-aided design (CAD) and com-
puter-aided manufacturing (CAM) with a microproces-
sor-driven CNC Lathe (Light Duty). The system allows
students to practice computer numerical controlled (CNC)
code programming and editing, learn to operate lathe
components, controls, and tools, set a programmed
reference zero, follow the steps necessary to turn a
specified part, and apply the machine code language to
current lathe technology.

The CNC lathe consists of a horizontal lathe con-
structed with a machined steel bed, head-stock, and
tailstock. It can machine pieces of soft materials such as
plastics and waxes, as well as harder materials such as
aluminum and brass. Pieces can be turned into a variety

of cylindrical bumps, grooves, and hollows. Stock is
mounted onto the lathe using a 3-jaw chuck that centers
the stock and holds it in place. Two lead screws, each
driven by a stepper motor, are used to move the cross
slide that carries the cutting tool along the Z-axis (right
and left) and X-axis (in and out). The speed of each
stepper motor can be programmed separately for feed
rates up to 356 mm/min (14 in/min). A 160-W (0.21-hp)
motor rotates the spindle and chuck, and thus the stock,
at speeds programmable up to 2800 r/min.

A computer (not included) is used to create part
programs with G and M machine codes or their conversa-
tional code equivalents. The created programs are up-
loaded to the lathe's on-board microprocessor, which
stores and executes them. Since the CNC Lathe connects
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directly to the serial or Ethernet port of a computer, or
directly to a network, no additional interface card is re-
quired. The computer is free to be used for any additional
applications, since it is not dedicated to the control of the
lathe.

The CNC Lathe is designed for use with the included
Lab-Volt CNC Lathe Software, Model 5560. This Win-
dows®-based software permits creation of G and M code
part programs for download to the CNC Lathe. It features
CAD/CAM design and tool path emulation, which allow
students to create a drawing of a part, set up the tool
paths and cut steps, and create a part program to simu-
late tool motion onscreen in order to verify NC code and
the finished part prior to the actual cutting. Canned cycles
can be programmed. The software can import NC part
programs created with other CAM programs that support
the G and M codes.

The CNC Lathe features a control panel that permits
the lathe to be operated manually. This panel includes a
multiple-line LCD display, an easy-to-use membrane
keypad, an error indicator/pause button, and a
key-released emergency stop push-button. The lathe
parameters, including the spindle speed, the feed rate,
the reference point, and the X and Z axes coordinates of
the cutting tool are adjusted by accessing different
menus. During the turning, the control panel displays the
Xand Z axes coordinates of the cutting tool, the feed rate,
and the spindle speed.

The CNC Lathe is designed for maximum safety. A
safety door provides protection during machining. Mag-
netic interlocks located on this door stop the spindle and
the axes if the door is opened during machining. Limit
switches prevent the bed from over-traveling and the
cutting tool from crashing into the chuck. Pressing the
emergency stop push-button on the control panel cuts off
the power to the spindle motor and stops the axes.

The CNC Lathe supports low-voltage communica-
tions with robotic units. For this purpose, the CNC Lathe
features a 15-pin TTL/IO port providing four 5-V digital
input and four 5-V digital output lines for TTL communica-
tion to an automation work cell. The CNC Lathe also
features a 5-pin solenoid driver port providing connections
for up to four auxiliary devices. The TTL/IO and solenoid
driver ports are M code supported through the CNC Lathe
Software, Model 5560.

The CNC Lathe comes with the accessories, soft-
ware, and cables required for its operation. These in-
clude, a carbide insert cutting tool, a set of six cutting
tools (types AR4, AL4, BR4, BL4, C4, and E4), several
pieces of machinable Delrin®, a serial cable, a cross-over
Ethernet cable, and a copy of the CNC Lathe Software
for a single user.

Also included are two user guides. One user guide
directs students in hands-on experiences with equipment
designed to prepare them for the automated manufactur-
ing environment. A user guide for the CNC Lathe Soft-

ware, Model 5560, is also included. It provides documen-
tation describing the features of the CNC Lathe Software.

To enhance or expand the capabilities of the system,
an assortment of machining tools and stock materials of
different sizes are offered as options.
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Lathe Features

» On-board microprocessor
» Full manual control mode
» Feed rate override

» Spindle speed override

Safety Features

 Fully enclosed bed and work area

» Key-released emergency stop push-button

« Error indicator/pause button

» Switches monitored by the machine for:
— safety door open
— tool post too close to the chuck
— over-travel protection on each axis

« Ability to restart programs from stopping point after
operator aborts or safety interruption has been cor-
rected.

Control Panel Feature
» Main power LED indicator
» 20-character by four-line LCD display
* 12-key membrane keypad
» Manual mode controls for:
— X and Z axes coordinates
units used (millimeters or inches)
feed rate
spindle speed
— TTL I/O and solenoid outputs
During execution, display of
— X and Z axes coordinates
feed rate
spindle speed
current G and M codes
TTL I/0O and solenoid output status
tool change



CNC LATHE SOFTWARE

This Windows®-based software runs under Windows® XP
and Vista. It features a parametric-based graphical tool
editor, a 3D (three-dimensional) Tool Path Emulator, and
an easy-to-use graphical interface. The software can
import NC part programs created with other CAM pro-
grams that support the G and M codes.

Features

 Provides G- and M-code programming

 Pull-down menus and icons

« Editor printout of part program

 Part program error checking using a syntax parser

« Fast syntax verification with line highlighting to speed
part program debugging

Full 3D Tool Path Emulator including:

Path and Tool trace view

Radius or Diameter view

Part rotation and camera positioning for better emu-
lation viewing

Zoom in/zoom out capability

Interface with the tool table to provide an accurate
tool simulation

Active display of X and Z axes coordinates
Display of current tool

Display of current G and M codes

Display of current feed rate and spindle speed
Simulation of current solenoid and 1/O port activity
Real-time estimation of machining time

Editor line highlighting while emulating part program
to track progress

Parametric, graphical view tool editor with support for
20 tools

Full G and M code help with graphical display and
example code

Simple CAD-CAM graphical development of part pro-
grams, including:

CAD editor to provide a simple yet powerful design
for ease of use

Standard turning cycles that can be graphically
created

Integrated materials database that provides speed,
feed, and rough/finish cut settings

CAM export utilizing tool table and materials for part
program parameters

Serial and Ethernet download support for the Lab-Volt
Automation CNC lathes



CNC LATHE SYSTEM (LIGHT DUTY)
MODEL 5300

TABLE OF CONTENTS OF THE USER GUIDES

CNC Lathe, User Guide 39546-E0

» Section 1 — Overview and Installation
Functional description

Front panel

Back panel connectors

Control panel

» Section 2 — Tools and Accessories
— Cutting tools
— Tool posts
— Mounting a cutting tool in a tool post
— Tool vertical alignment
— Tool post alignment
— Mounting a cut-off tool
— Cutting precision
— Installing a four-jaw chuck

» Section 3 — Using the Lathe Interface
— The lathe firmware
— Feedrate
— Spindle speed

» Section 4 — Turning Stock
— Loading the stock
— Setting the PRZ
— Connecting the lathe to a computer or to an
Ethernet network
— Downloading a program
— Executing a part program

» Section 5 — Tutorial Exercise
— Tutorial

* Section 6 — Maintenance
— Routine maintenance
— Updating the firmware

CNC Lathe Software, User Guide 36188-E0

o Section 1 — Overview of the CNC Lathe Software

The Main Screen
The Toolbar
The Menu Bar

* Section 2 — Menus

The File Menu
The Edit Menu
The Search Menu
The Lathe Menu
The Options Menu
The Window menu
The Help menu

e Section 3 — The Part Program Editors

The Line Editor
The CAD/CAM Editor
The Block Editor

¢ Section 4 — Tutorial Exercices

Creating a simple G and M code part program
with the Line Editor

Emulating and downloading a G and M code part
program

Creating, editing, and exporting a simple
CAD/CAM drawing with the CAD/CAM Editor
Creating, editing, and exporting a simple block
part program with the Block Editor

LIST OF EQUIPMENT

CNC Lathe System (Light Duty), Model 5300-20

QTY  DESCRIPTION

ORDERING NUMBER'

1 CNC Lathe (Light DUty) . . .. ..o e e e e 5300-B0
1 CNC Lathe Software for one USEr . . . ... .. e 5560-00
1 Black/White Delrin® Turning Stock Package .. ............... i 5304-00
1 CNC Lathe Software, User GUIde . ... ... .. i e e e 36188-E0
1 CNC Lathe, User GUIde . .. ... ... e 39546-E0

" The ordering numbers shown apply to the English 120-V version. Other versions are available. Refer to the Ordering Numbers section.
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OPTIONAL EQUIPMENT
DESCRIPTION

ORDERING NUMBER?

Black/White Delrin® Turning Stock Package . . ... ...........ui et 5304-00
Black Delrin® Turning Stock Package .. ... ...ttt e e e 5305-00
White Delrin® Turning Stock Package . ... .......... .ttt e 5306-00
Aluminum Turning Stock Package . . ... ... . .. e 5307-00
Brass Turning Stock Package . . ...... ... .. 5308-00
TUiNg TOOl Set . . ..o e 5322-00
Basic Turning Kit . . ... 5323-00
Aluminum Turning Stock Package . . ... .. ... . e 5357-00
CNC Lathe Software . ... ... e e e 5560-00
Carbide Tool Set . . ... . 32913-00
Parting-off Tool and Holder . .. ... .. .. . 96862-00
SPECIFICATIONS
Model 5300-B — CNC Lathe (Light Duty) 120 V- 60 Hz 220 V- 50 Hz 240 V- 50 Hz
Power Requirement Current 3A 1.5A 1.5A
Lathe Swing Over Bed | 90 mm (3.5 in)
Center Height | 101.6 mm (4 in)
Distance Between Centers | 200 mm (8 in)
Swing Over Cross Slide | 48 mm (1.9 in)
X-Axis Travel | 47.8 mm (1.88in)
Z-Axis Travel | 105.4 mm (4.15in)
Resolution | +0.00318 mm (+0.000125 in)
Headstock Spindle Bore | 10 mm (0.405 in)
Spindle Taper | Morse No. 1
Tailstock Tailstock Taper | Morse No. 0
Sleeve Stroke | 38.1 mm (1.51n)
Main Spindle Drive Programmable Speed Range | 0-2800 r/min
Motor | 160 W (0.21 hp), overload protected
Feed Motors Type | Stepper
Resolution | 400 steps/r

Rapid Traverse Speed

356 mm/min (14 in/min)

Accessories included in Model 5300-B

Carbide Insert Tool with Tool Post

35° right-hand insert

Carbide Tool Set with Tool Post Types | AR4, AL4, BR4, BL4, C4 and E4
Null Modem Serial Cable Length = 3.05m (10 ft)
Connectors | DB9 female/female
TTL/IO Cable Length | 3.05m (10 ft)
Connectors | DB15 male/male
Ethernet Crossover Cable Length = 2.13 m (7 ft)
Connectors | RJ45 male/male
Set of Tools Content | hex keys, cleaning brush, digital caliper and tool bag

2 The ordering numbers shown apply to the English 120-V version. Other versions are available. Refer to the Ordering Numbers section.
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SPECIFICATIONS (cont'd)

Accessories included in Model 5300-B (cont'd)

Fuses Current Rating

Voltage Rating

1.0A

250V

Physical Characteristics Dimensions (H x W x D)

Net Weight

750 x 864 x 597 mm (29.5 x 34 x 23.5 in)
68 kg (150 Ib)

Model 5304 — Black/White Delrin® Turning Stock Package

Quantity

50 white and 50 black

Dimensions
Model 5305 — Black Delrin® Turning Stock Package

19 mm (0.75 in) diameter, 76.2 mm (3 in) long

Quantity

100

Dimensions

19 mm (0.75 in) diameter, 76.2 mm (3 in) long

Model 5306 — White Delrin® Turning Stock Package
Quantity

100

Dimensions

19 mm (0.75 in) diameter, 76.2 mm (3 in) long

Model 5307 — Aluminum Turning Stock Package

Quantity
Dimensions

Model 5308 — Brass Turning Stock Package

100
19 mm (0.75 in) diameter, 50.8 mm (2 in) long

Quantity

25

Dimensions
Model 5322 — Turning Tool Set

12.7 mm (0.5 in) diameter, 76.2 mm (3 in) long

Indexable Carbide Tool Set Types

TAR, TAL, TBR, TBL, and TE with 9.53 mm (0.375 in) shank

Carbide Inserts

ten, C-2 grade, 6.35 mm (0.25 in) inscribed circle

Two-Position Tool Post
Model 5323 — Basic Turning Kit

mounts one 7.94 mm (0.3125 in) tool and one 9.53 mm (0.375 in) tool

High-Speed Steel Cutting Tool Set

three-piece set including a right-hand tool, a left-hand tool, and a boring
tool, all 6.35 mm (0.25 in) square type

Parting-Off Tool and Holder
Cutting Tool with Tool Post

see Model 96862
6.35 mm (0.25 in) shank, high speed steel

Model 5357 — Aluminum Turning Stock Package

Quantity 100

Dimensions 12.7 mm (0.5 in) diameter, 63.5 mm (2.5 in) long
Model 5560 — CNC Lathe Software

Licenses Number of Users | 1, 5, 10, 15, 20, 25, 30 or 35

Computer Requirements (minimum) Type

Operating system

Pentium I, 400 MHz

Windows® 98/ME, NT 4.0/2000 or Vista

RAM | 32 MB
Graphic Card | 3D
Model 32913 — Carbide Tool Set
Types | AR4, AL4, BR4, BL4, C4 and E4
Model 96862 — Parting-off Tool and Holder
Holder Type | for parting-off blade
Parting-off Blade Material | high speed steel (HSS)




ORDERING NUMBERS

120 V - 60 Hz 220 V - 50 Hz 240 V — 50 Hz
ENGLISH FRENCH SPANISH ENGLISH FRENCH SPANISH ENGLISH
5300-20 TBE® TBE 5300-25 TBE TBE 5300-2A
5300-B0 TBE TBE 5300-B5 TBE TBE 5300-BA
5304-00 5304-00 5304-00 5304-00 5304-00 5304-00 5304-00
5305-00 5305-00 5305-00 5305-00 5305-00 5305-00 5305-00
5306-00 5306-00 5306-00 5306-00 5306-00 5306-00 5306-00
5307-00 5307-00 5307-00 5307-00 5307-00 5307-00 5307-00
5308-00 5308-00 5308-00 5308-00 5308-00 5308-00 5308-00
5322-00 5322-00 5322-00 5322-00 5322-00 5322-00 5322-00
5323-00 5323-00 5323-00 5323-00 5323-00 5323-00 5323-00
5357-00 5357-00 5357-00 5357-00 5357-00 5357-00 5357-00

32913-00 32913-00 32913-00 32913-00 32913-00 32913-00 32913-00

96862-00 96862-00 96862-00 96862-00 96862-00 96862-00 96862-00

36188-E0 TBE 36188-E2 36188-E0 TBE 36188-E2 36188-E0

39546-E0 TBE TBE 39546-E0 TBE TBE 39546-E0
Table 1. Equipment Ordering Numbers (Domestic and International Markets).

NUMBER 120 V - 60 Hz 220 V - 50 Hz 240 V — 50 Hz

OF USERS ENGLISH FRENCH SPANISH ENGLISH FRENCH SPANISH ENGLISH

1 5560-00 TBE 5560-02 5560-00 TBE 5560-02 5560-00
5 5560-A0 TBE 5560-A2 5560-A0 TBE 5560-A2 5560-A0
10 5560-B0 TBE 5560-B2 5560-B0 TBE 5560-B2 5560-B0
15 5560-C0 TBE 5560-C2 5560-C0 TBE 5560-C2 5560-C0
20 5560-D0 TBE 5560-D2 5560-D0 TBE 5560-D2 5560-D0
25 5560-E0 TBE 5560-E2 5560-E0 TBE 5560-E2 5560-E0
30 5560-F0 TBE 5560-F2 5560-F0 TBE 5560-F2 5560-F0
35 5560-G0 TBE 5560-G2 5560-G0 TBE 5560-G2 5560-G0

® TBE = To be established

Table 2. Software Ordering Numbers
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